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ABOUT THIS GUIDE 
 
This guide will take you through the main features of the Cbox software named Amalga. 
 
Please note that there are two categories of features: 

- Base: Those features are available on all Cbox appliances. 
- Optional: Those features may be disabled or not supported on your Cbox. 

A feature may be disabled because this is a lower cost Cbox. However, it is possible to enable a 
feature upon approval of your account manager at Winnov. 
A newer feature may not be supported because this is an older Cbox platform. However, it is 
possible to upgrade your hardware within the conditions of your Cbox support plan (CSP). 

 
The optional and base features are identified in this guide. 
 
 

COPYRIGHT 
 
No part of this document may be photocopied, stored in a retrieval system, transcribed, or reproduced by 
any method, be it mechanical, electronic, photographic, or otherwise, without prior written permission from 
Winnov. 
 
This appliance is protected by copyright law and international treaties. Unauthorized reproduction or 
distribution of this program, or any portion of it, may result in severe civil and criminal penalties, and will 
be prosecuted to the maximum extent possible under the law.  
 

Copyright © 2015 by Winnov, Inc. All rights reserved. 
 
 

DISCLAIMER 
 
Winnov shall not be liable for any incidental or consequential damages resulting from the performance or 
use of this product. 
 
Winnov makes no warranty of any kind with regard to this material, including, but not limited to, implied 
warranties of merchantability and fitness for a particular purpose. 
 
Winnov continuously improves and updates the products described in this document to suit the needs of 
our customers. The contents of this document and the specifications of the hardware devices and 
software are subject to change at any time without notice.  
 
 

TRADEMARKS 
 
Winnov Cbox is a registered trademark of Winnov. 
Other trademarks mentioned in this document are owned by their respective companies. 
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STARTING WINNOV CBOX FOR THE FIRST TIME 
 
 
To start the Cbox appliance, push the power button once and wait 3 seconds. The system will start. 
 

Two accounts are already created on the Cbox: Administrator and 
Cbox User 
There is a password for the Administrator account: Cbox1234. 
We recommend that you change this password after your first login. 
 
There is no password for the Cbox User account. 
 

 
 

Winnov recommends you DO NOT INSTALL other software on Cbox. 
Winnov shall not be liable for any incidental or consequential damages resulting from installing 
non-recommended software on this product. 

 
  



WINNOV CBOX SOFTWARE USER GUIDE  9 

 

 

ABOUT AMALGA 
 
Amalga is Winnov’s rich media capture software which runs on the Cbox appliance. 
 
To launch Amalga, double-click the Amalga shortcut on your Windows desktop: 
 
 
 
 

START SCREEN 
 
At launch, the Amalga Start Screen is presented.  
 

 
 

Figure 1 – Amalga Start Screen with Builder Interface 

 
 

Figure 2 – Amalga Start Screen with Studio Interface 

 
         

The Amalga Start Screen gives you the option to access Amalga user interfaces or browse the archive 
directory to access your recordings. 
 

Builder 
 

OR 

 
Studio 

Clicking the button will take you to the Builder / Studio interface: 
 
A user interface which is used to create mixes for different outputs and to define presets that will be 
used for recording a presentation. Different configurations can be saved for each individual 
presenter or use case. 
 
The Studio interface is the Builder interface with the capability to record. Please note that the Studio 
interface is an optional feature. 

 

Clicking the button will take you to the Touch interface: 
 
A simplified user interface designed for the presenter. It provides all the functionality required for a 
presenter to create a recording and to switch among various mixes using the presets created within 
the Studio / Builder interface. 

 

Clicking the button will open a Windows Explorer window where your recordings are archived. 
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START SCREEN MENU BAR  
 
For easy navigation, the following menus are available in the menu bar. 
 

 
 

Figure 3 – Menus 

FILE 
 
The File menu contains the same options as displayed on the Start Screen. Select the File menu to 
access the Builder / Studio interface, the Touch Interface, the Archives, or exit the application. 
 

 
 

Figure 4 – File Menu  

VIEW 
 
The View menu contains the Fullscreen option. When enabled, Amalga will launch in full screen mode. 
 

 
 

Figure 5 – View Menu 
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TOOLS 
 
From the Tools menu, you can launch the Hardware Configuration Console, access Amalga’s 
Scheduler, and modify general Options to customize functionality within Amalga. 

 

 
 

Figure 6 – Tools Menu 

This document first describes the Hardware Configuration Console since it is the tool of Amalga to set 
up your audio and video sources. 
 
 

HELP 
 
The Help menu displays the following three items: 
 

 
 

Figure 7 – Help Menu 

 Product Website: Opens a web browser and directs the user to the Amalga’s product page. 

 Check for Updates: Opens a web browser and directs the user to the Amalga’s software 
updates page from which updates can be downloaded (drivers, players and other software 
releases). 

 About: Displays Product Version and Assembly Version of Amalga. 
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The Hardware Configuration Console is the tool for setting up your audio and video sources. 
It consists of three main areas: 

- The Audio Control Panel 
- The Video Control Panel 
- The PTZ Joystick Control Panel 
 

 
 

Figure 8 – Hardware Configuration Console 

 

It is not recommended to leave the Hardware Configuration Console open while recording 
with Amalga. 
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1 VIDEO CONTROL PANEL 
 
The Video Control Panel consists of controls that determine incoming video signals into Amalga. All 
Video Sources give you control over Brightness, Contrast, Saturation, Hue, Luma Gain, Chroma Gain 
and Sharpness. Both Luma Gain and Chroma Gain also have Auto levels that can be enabled by 
checking the appropriate checkboxes. 
 

 
 

 
Figure 9 – Video Control Panel 
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1.1 GENERAL 
 
Source Info 
Source Info provides information about the video signal coming into the Cbox via A/V Breakout Cable. 
The Signal Locked indicator signifies whether or not a video signal is present by providing either a “True” 
or “False” value. Lines Detected displays the number of lines of resolution detected in the video signal 
(525 for NTSC sources or 625 for PAL sources). 
 
Standard 
Cbox accepts both NTSC and PAL sources. The Standard selector allows you to select either NTSC or 
PAL depending on the source you have connected to the Cbox. 
 
 
Source 
The Source selector allows you to select the correct video input which is physically connected to your 
Cbox. 
 
Equipment 
The Black & White and VCR options under Equipment allow you to optimize incoming video depending 
on sources being used. 
 

 Check Black & White if a black and white video source is being used. This removes the chroma 
signal and produces a better overall black and white image. 

 

 Check VCR if a tape video source is being used. This adjusts the video decoder for a better 
overall image. 

 
Flipping 
You can apply Vertical and Horizontal flipping of video sources by checking the appropriate checkbox. 
This is useful for cameras that require special mounting requirements such as cameras mounted upside 
down. 

1.2 SPECIFICS 
 
Analog Video 
Analog Video is the analog video input (composite) which is available on your Cbox via the A/V 
Breakout Cable (Breakout Cable version) or rear chassis labeled “VIDEO IN” (Push Pin version). 
 
SDI 1, 2, and 3  
SDI 1, 2, and 3 are the HD / 3G-SDI video inputs which are available on your Cbox via the BNC 
connectors.  
 
DVI 1 and 2  
DVI 1 and 2 are the DVI / HDMI / RGB / Component video inputs which are available on your Cbox via 
the DMS-59 adapter cable.  
   
 
By default, 2 (upgradeable to 3) HD input channels are enabled on the Cbox L3. 
By default, 3 (upgradeable to 5) HD input channels are enabled on the Cbox S3.  
Additional HD input channels may be enabled upon approval of your account manager at Winnov 
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1.3 PTZ CAMERA 

 
The PTZ Camera selector allows you to assign the PTZ Camera. Cbox auto-discovers the PTZ Cameras 
available for control and the dropdown menu would be populated as follows: 
 
 

 
 

Figure 10 – Video Control Panel  /  PTZ Camera 

 

- Cbox supports Panasonic PTZ Camera devices (AW-HE2, AW-HE40, AW-HE50, AW-HE120, 
AW-HE130) over IP. PTZ camera controls can be accessed from the Studio / Builder Interface. 
PTZ presets can be associated with the Audio / Video Mix Presets. 

- For instance, it will populate the dropdown menu as shown below: 
 

 
 

Figure 11 – Video Control Panel  /  PTZ Camera Over IP 
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Once assigned, a PTZ button     will be displayed in the Studio / Builder user interface of Amalga for 
the specified video input. Clicking on the PTZ button will display the PTZ control screen as shown below: 
 

 
 

Figure 12 – PTZ Control Screen 

1.3.1 SETTING AND ACTIVATING CAMERA PRESET SELECTIONS  

To set and activate a Preset Selection, follow the steps below: 
1. Use the buttons to pan, tilt, zoom in, and zoom out to adjust your camera  
2. Click the Set button that corresponds to the camera preset you wish to assign. You may assign 

up to 6 presets per camera. 
3. Click Go to activate the set preset  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13 – Setting and Activating Camera Preset Selections 
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1.3.2 ASSOCIATING PTZ PRESETS WITH CBOX PRESETS 

PTZ presets can be associated with Cbox Presets. To associate a PTZ preset to a Cbox preset, follow the 
steps below: 

1. Be sure to Set the camera preset you wish to assign  
2. Click the desired PTZ preset tile and drag into the Cbox preset in the Presets column 
3. Repeat steps 1 and 2  to assign multiple PTZ presets to multiple Cbox presets  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14 – Assigning PTZ Presets to Cbox Presets 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 AUDIO CONTROL PANEL 
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The Audio Control Panel includes controls for the audio inputs / output. Audio inputs can be renamed to 
identify audio sources more easily. Amalga will use and display the audio sources names as they appear 
in the Hardware Configuration Console. 
 

 
 

Figure 15 – Audio Control Panel 
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2.1 GENERAL 
 
VU Meters indicate the overall level of an Audio Source. 
 
Volume sliders allow you to cut or boost Audio Source levels as needed. In the case of Speaker, the 
volume sliders are used to control outgoing audio levels. 
 
All values can be reset to their default values by right-clicking the audio source and selecting Reset. 
 

2.2  SPECIFICS 
 
Audio 1 In, 2 In, and Audio 3 In (Breakout Cable version) 
This Audio Source represents the four XLR inputs labeled AUDIO 1 IN and AUDIO 2 IN, and AUDIO 3L 
AUDIO 3R IN on the A/V Breakout Cable version. These Audio Sources are typically used from balanced 
mono microphones and in-room audio mixing board. 
Attenuation can be adjusted to cut audio by -10 dB by selecting the appropriate radio button. 
 
Audio 4 In - Audio 7 In (Breakout Cable version) 
These Audio Sources represent the four RCA sockets labeled AUDIO 4L IN and AUDIO 4R IN, AUDIO 
5L IN and AUDIO 5R IN, AUDIO 6L IN and AUDIO 6R IN, AUDIO 7L IN and AUDIO 7R IN on the A/V 
Breakout Cable version. 
 
Audio 1 In and 2 In (Push Pin version) 
This Audio Source represents the four terminal block inputs labeled AUDIO 1L IN and AUDIO 1R IN, 
AUDIO 2L IN and AUDIO 2R IN on the Push Pin version. This Audio Source is typically used from an in-
room audio mixing board. 
Attenuation can be adjusted to cut audio by -10 dB by selecting the appropriate radio button. 
 
 
Audio 3 In - Audio 5 In (Push Pin version) 
These Audio Sources represent the 1/8” mini-jack on the back of appliance labeled IN 3, IN 4, IN 5 on the 
Push Pin version.  
 
Audio Out 
Audio Out represents the two XLR outputs or terminal block labeled AUDIO L OUT and AUDIO R OUT 
on the A/V Breakout Cable or Push Pin version. Audio Out is associated with Amalga’s Audio Out output 
in the A/V Equipment category in the Output Wizard. 
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SDI Source 1, 2, and 3 Audio Ch 1 / 2 
 
SDI Sources 1, 2, and 3 Audio Ch 1 / 2 are the SDI embedded audio inputs, which are available on your 
Cbox via the BNC connectors. Two channels of embedded audio are available for each SDI Video 
Source. 
 
Since SDI embedded audio is digital, there is no analog gain to be applied at a physical level and there is 

no phantom power, so all controls are greyed out. However, gain can still be adjusted at the software 

level (see Studio / Builder Interface). 

DVI 1 and 2 Audio 
 
DVI 1 and 2 Audio supports embedded HDMI audio inputs, which are available on your Cbox via the 
DMS-59 adapter cable. One channel of embedded audio is available for each HDMI Video Source. 
 
 

 
 

 
Figure 16 – Audio Control Panel / SDI Embedded Audio / HDMI Embedded Audio 
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BASE FEATURES 
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STUDIO / BUILDER INTERFACE 
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3 GENERAL MENU OPTIONS 
 
For easy navigation in the Studio / Builder Interface, the following menus are available in the Amalga 
menu bar. 
 

 
 

Figure 17 – Menus 

3.1 FILE 
 

The File Menu contains the following options: 

 
 

Figure 18 – File Menu 

 New Session: Creating a new session configuration from scratch. 

 Load Session: Loading a Session allows you to retrieve the previous configurations that you 
have already saved. 

 Save Session As: Saving your current session allows you to save the current configuration 
(metadata, inputs, outputs, presets). 

 Archives: will open a Windows Explorer window where your recordings are archived. 

 Exit to Start Menu: will bring you back to the start screen. 
 

 

3.2 VIEW 
 
The View menu contains the Fullscreen option. When enabled, Amalga will launch in full screen mode. 
 

  
 

Figure 19 – View Menu 
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3.3 SESSION 
 

The Session Menu contains the following options: 

 
 

Figure 20 – Session Menu 

 Properties: Clicking on Properties allows you to go back to the Session Properties dialog. For 
more information, see the “Session Properties” section. 

 Record: Clicking on Record starts/stops a recording. This serves the same function as clicking 
the Record button. This option is not available in the Builder Interface. 

 

3.4 TOOLS 
 

The Tools Menu contains the following options: 

 

 
 

Figure 21 – Tools Menu 

 Hardware Configuration: will launch the Hardware Configuration Console. For more information, 
see the “Hardware Configuration Console” section. 

 Scheduler: will open the Scheduler window 

 Options: will open a window to set the general options.  
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The Sessions tab is where a Pre-Record Action and/or Post-Record Action is specified. 

 
 

 
 

Figure 22 – Options Window / Sessions Tab 

Pre-Record Actions are actions initiated when a recording begins, such as running an executable to 
perform a task when a recording begins. The Pre-Record Action options are: 
 

 None: Performs no action when a recording is started. This is the default option. 

 Run: Performs the task specified in the Path field when starting a recording. 

 Arguments: Passes optional parameters to the executed task when starting a recording. 

 Wait for Completion: Begins recording after completion of the task specified in Run. Leaving this 
unchecked will immediately start the recording, even if the specified Run task is still running. 
 

Post-Record Actions are actions initiated when a recording is stopped. The Post-Record Action options 
are: 
 

 None: Performs no action when stopping a recording. 

 Run: Performs the task specified in the Path field when stopping a recording. 

 Arguments: Passes optional parameters to the executed task when stopping a recording. 

 Wait for Completion: Stops the recording after completion of the task specified in Run. Leaving 
this unchecked will immediately stop the recording, even if the specified Run task is still running. 

 Show Folder View: Opens the directory in which the recordings are archived in an Explorer 
window. This is the default option. 
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The Archives option is where the path to the directory of your recordings will be archived. 
 
 

 
 

Figure 23 – Options Window / Archives Tab 

The default path to the Archives is: C:\Archive 
 
Clicking the Reset button will set the archive directory path back to this default directory. 
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Enabling the Remote Control option allows Amalga to be controlled remotely via API. 
 
 

 
 

Figure 24 – Options Window / Remote Control Tab 

The following options are available under Connectivity:  
 
1 Port: Specifies the port through which the remote API will communicate. 
2 Object Name: Specifies the name of the object that will be used to communicate with the API. 
 
For details on how to use Amalga’s Remote API, there is a supplemental Amalga Remote API 
document. 
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Under the General options tab, you will find the “Show Session Properties dialog on application start 
up” and “Show Metadata view” options. 
 
 

 
 

Figure 25 – Options Window / General Tab 

When enabled, Amalga’s Session Properties dialog and Metadata view will appear upon launching the 
Studio / Builder Interface. These options are enabled by default. 
 

3.5 HELP 
 
The Help menu displays the following three items: 
 

 
 

Figure 26 – Help Menu 

 Product Website: Opens a web browser and directs the user to Amalga’s product page. 
 

 Check for Updates: Opens a web browser and directs the user to Amalga’s software updates 
page from which updates can be downloaded (drivers, players and other software releases). 

 

 About: Displays Product Version and Assembly Version of Amalga.  
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4 SESSION PROPERTIES 
 
When starting the Studio / Builder Interface, the Session Properties dialog will appear by default. 

You can also access the Session Properties dialog by clicking on this button:   
 
The Session Properties window includes tabs to define and configure Metadata, Inputs and Outputs 
for a specific session. 
 
 

4.1 METADATA 
 
Metadata is the information about a specific session. 
 
Under the Metadata tab, you can define and type in the Title, Author, Description, Keywords and 
Copyright details of a session. 
 
 

 
 

Figure 27 – Session Properties Window / Metadata Tab 
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4.2 INPUTS 
 
The Inputs tab is where audio and video sources for a recording are managed. 
 
 

 
 

Figure 28 – Session Properties Window / Inputs Tab 

 

4.2.1 CREATING INPUTS 

 
1. To create an input, click on the Create… button. 

 
2. Select the input Type. Choose between Audio Device, Video Device, or Other Video Device. 

 

 
 

 
Figure 29 – Input Editor / Type 

. 
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3. Then select the Source for the input to be used in Amalga. The Source options will be displayed 
as the names set in the Hardware Configuration Console. 

 
 

  
 

Figure 30 – Input Editor / Source 

4. After a Source has been selected, give the source a Name if you wish to specify a name other 
than the default. This name will identify the input in the user interface. 
 

5. Click the OK button to confirm the input selection. 
 

 

 
 

Figure 31 – Input Editor / Name 

6. Repeat steps 1 - 5 to create additional inputs. 
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4.2.2 EDITING INPUTS 

 
1. To edit an input, select the input you wish to edit in the Inputs tab and click the Edit button. You 

can also double-click the selected input. 
 

 

Figure 32 – Input Editor / Modify Name 

 
2.   You can modify the Name of the input (the type and the source cannot be modified).  
Deleting Inputs 

 
1. To delete an input, select the input you wish to delete in the Inputs tab and click the Delete 

button.  
 

 

Figure 33 – Input Deletion 

2.   You will be asked to confirm deletion of the input. The action cannot be undone once you have 
confirmed deletion of an input.    
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4.2.3 ADVANCED INPUT EDITOR 

 
The Advanced Input Editor allows you to crop and scale a Video Device source. 
 

 
 

Figure 34 – Advanced Input Editor 

1. Access the Advanced Input Editor and apply advanced modifications by clicking the Advanced 
button when creating/editing a Video Device input. 

 
2. The Advanced Input Editor window will appear with two video preview panes. 

a. The Source pane indicates the width, height and frame rate of the video source as Cbox 
captures it. 

b. The Target pane allows you to modify the width, height and frame rate of the input and 
allows you to define a cropping rectangle to crop your video inputs. 

 
3. Checking the Deinterlace checkbox will apply deinterlacing to the video source. 

 
4. Selecting Auto Format will automatically format the video source without applying any scaling or 

cropping. This option is enabled by default. 
 

5. For Cropping: 

 Uncheck the Auto Format checkbox 

 Define the Width and Height of the Target 

 Define the Width and Height of the Cropping Rectangle with the following conditions: 
o Crop Height < Target Height 
o Crop Width < Target Width 

 Define the Left and Top values for positioning the Cropping Rectangle with the following 
conditions: 

o Crop Height + Top < Target Height 
o Crop Width + Left < Target Width 

 
 

Cropping 

Rectangle 

400 x 300 

Top = 200 

Left = 300 
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4.3 OUTPUTS 
 
The Outputs tab is where you specify the types of outputs you wish to create for your recordings. An 
“output” can be a file for playback, a live stream, or output signal to hardware such as a projector or PA 
system. Each output mix is customizable to ensure that it is optimized for each targeted device. 
 

 
 

Figure 35 – Session Properties Window / Outputs Tab 

4.3.1 CREATING OUTPUTS 

 
1. To create an output, click on the Create… button to launch the Output Wizard. 

 
2. In the Output Wizard, select a Category for the output type you wish to create. 

 

 
 
 

Figure 36 – Output Wizard / Category 
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3. After selecting an output Category, a list of output Types for the selected Category will be 
displayed. Select the Type of output by double-clicking the output type, or by selecting the output 
type then clicking the Next > button. 

 

 
 

Figure 37 – Output Wizard / Type 

4. After selecting the Type of output you want, you are presented with Configuration options for the 
selected output Type. 
 

 
 

Figure 38 – Output Wizard / Type / Configuration / Name 
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5. Enter a Name for the selected output Type if you wish to specify a name other than the default. 
 

6. You may select a pre-defined Profile for the selected output Type.  
These Profiles consist of commonly used resolutions and bit rates. 
 

 
 

Figure 39 – Output Wizard / Type / Configuration / Profile 

7. An Action can be specified if one is available for the output type. To select the Action, click on 
the Action drop-down menu. For instance, an action may be used to associate a specific player 
to Silverlight outputs. 

 

 
 

Figure 40 – Output Wizard / Type / Configuration / Action 

8. You can apply more advanced modifications in the Output Options menu by clicking the 
Options button. Please refer to the appendix which describes Output Options for some specific 
output types. 
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4.3.2 EDITING OUTPUTS 

 
1. To edit an output, select the output you wish to edit in the Outputs tab and click the Edit button. 

You can also double-click the selected output. 
 

 
 

Figure 41 – Output Editor 

2. You can modify the name, profile and action of the output. You can also apply modifications in the 
Output Options by clicking the Options button. Please refer to the appendix which describes 
some specific output types and advanced output options.  
 

 
 

Figure 42 – Output Options 
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4.3.3 DELETING OUTPUTS 

 
1. To delete an output, select the output you wish to delete in the Outputs tab and click the Delete 

button. 
 

 
 

 
Figure 43 – Output Deletion 

2. You will be asked to confirm deletion of the output. The action cannot be undone once you have 
confirmed deletion of an output. 
 
 

There is a limit for the number of outputs, which can be processed at the same time. This 
may vary based on parameters such as Cbox hardware platform, level of motion, inputs 
resolution / frame rate and encoding settings.  
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5 MIXING 
 
Each output can be associated with custom audio and video mixes.  
This section describes how to customize audio and video mixes. 
The figure below identifies major areas of the user interface for custom audio and video mixing purposes. 
The user interface features a drag and drop scheme which can be applied from one area to another. 
 

 
 
 

Figure 44 – Major Areas of the User Interface / Drag and Drop Scheme 

 
 

 

 
 

 
 
 
 
 
 
 
 

 
 

  

  

 
  

 
  

  

Video Drag and Drop Workflow 

Audio Drag and Drop Workflow 
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5.1 MIXING VIDEO 
 
A custom video mix consists of one or more video inputs arranged in a canvas for a specific output. Each 
output can be mixed differently from one another to create the most effective mix for optimized viewing on 
a particular device (PC or laptop, smartphone, tablet, digital signage, projector). To create a video mix, 
follow the steps below. 
 

 

Select the output video to be mixed by holding the 
left mouse button down and dragging and dropping 
the output video from the Outputs Column into the 
Video Mix Pane. The output video will 
automatically update with the correct aspect ratio. 
 
 
The Video Mix Pane is where you arrange, scale, 
and apply custom settings for the video layout. 

  

 

Select the video inputs to be mixed by holding the 
left mouse button down and dragging and dropping 
the video inputs from the Video Inputs Column to 
the Video Mix Pane. 
 
Drop Zones will automatically scale your video 
inputs and will be highlighted in yellow. Bounding 
Boxes are shown as dashed lines. Video inputs 
that are dragged and dropped into the video mix 
pane will not exceed the bounding boxes.  

  

 

Create a custom video mix by arranging each of 
the video inputs as desired using Drop Zones. 
 
However, more precise video mixing can be 
performed and must be done in the Video Mix 
Pane. For more precise video mixing, click on the 
video input with the right mouse button and hold 
down. Reposition the video input as desired.  
 

  

 

When your custom video mix is complete, 
associate the video mix to the desired output by 
holding down the left mouse button and dragging 
and dropping the video mix into the appropriate 
output in the Outputs Column. 

 
Figure 45 – Creating Custom Video Mixes 
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5.2 MIXING AUDIO 
 
If your outputs require a special audio mix, follow the steps below to create the appropriate audio mix. By 
default, all audio inputs are set to maximum volume. 
 
 

 

To mix audio for an output, adjust the audio levels 
for each audio input as desired in the Audio Mix 
Pane. 

  

 

When audio levels are adjusted to your preference, 
associate the audio mix to the output by holding 
down the left mouse button and dragging and 
dropping the Master VU meter from the Audio Mix 
Pane into the VU meter for the appropriate output. 

 
Figure 46 – Creating Custom Audio Mixes 
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5.3 VIDEO SETTINGS AND MIX TEMPLATES 
 
Amalga gives you robust control over your video mixes. The following section will guide you through the 
various video settings and how you can save mixes as templates. 
 

5.3.1 VIDEO SETTINGS 

 

 

Figure 47 – Video Settings 

Video settings can be modified in the Video Mix Pane for a selected video input. A video input can be 
selected by: 

 Clicking the video input with the left mouse button in the Video Inputs Column. 

 Clicking the video input with the left or right mouse button in the Video Mix Pane.  
 

To resize and reposition the video: 

 While in the Video Mix Pane, select the video input to be resized and/or repositioned by holding 
down the left mouse button and dragging the input into various drop zones. 

 While in the Video Mix Pane, select the video input to be resized and/or repositioned by clicking 
on the left or right mouse button and using the scroll wheel to resize the input. To reposition the 
video input more precisely, select the video input by holding down the right mouse button and 
move the input around, releasing the mouse button once arranged in the desired position.  

 Select the video input to be resized and/or repositioned by clicking on the left or right mouse 
button and then manually enter values for width, height, horizontal offset, and vertical offset. 
 



WINNOV CBOX SOFTWARE USER GUIDE  46 

 

 

 
 

The video settings that can be modified are as follows: 
 

 

Horizontal Offset: Sets the horizontal offset from the center of the video mix 
[Range: -5.0000 – 5.0000] 

 

Vertical Offset: Defines the vertical offset from the center of the video mix 
[Range: -5.0000 – 5.0000] 

 

Width: Sets the width of the video input as it will appear in the Video Mix 
[Range: 0.0000 – 5.0000] 

 

Height: Sets the height of the video input as it will appear in the Video Mix 
[Range: 0.0000 – 5.0000] 

 

Yaw: Sets the yaw of the video input relative to the center of the video input 
[Range: -5.0000 – 5.0000] 

 

Pitch: Sets the pitch or vertical “tilt” of the video input relative to the center of the 
video input  
[Range: -5.0000 – 5.0000] 

 

Roll: Sets the roll or rotation of the video input relative to the center of the video 
input 
[Range: -5.0000 – 5.0000] 

 

Alpha: Sets the alpha or transparency of the video input 
[Range: 0.0000 – 1.0000] 

 

Gamma: Adjusts the gamma or gray levels between black and white are displayed 
for the video input 
[Range: 0.0000 – 5.0000] 

 

Brightness: Adjusts the overall brightness of the video input. 
[Range: -1.0000 – 1.0000] 

 
Contrast: Adjusts the overall contrast of the video input 
[Range: 0.0000 – 2.0000] 

 
Border Thickness: Controls the size of the video input’s border 
[Range: 0.0000 – 10.0000] 

 

Border Color: Determines the color of the selected video input’s border 
[Values: hexadecimal value or common color name. e.g., “red”] 

 
 
The values can be changed either by: 

 Hovering of the value area with the pointer, then holding down the left mouse button and moving 
the mouse left or right to increase or decrease the value of the setting. 

 Clicking on the value area with the left mouse button and manually enter in the value. 
 
Note: Clicking on the icon on the left of the value area with the left mouse button will reset it to the default 
value. 
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5.3.2 MIX BACKGROUND SETTINGS 

 
You can further customize your video mix by specifying a background color or background image for your 
mix. 
 

 

Figure 48 – Adding Mix Background Color / Background Image 

 

Change the color of the background by clicking the Background Color button    and 
entering either a hexadecimal value or common color name (e.g. “red”). 

Specify a background image by clicking the Background Image Browse button   
and selecting an image from your Cbox. 
 
Note: Amalga will stretch the selected Background Image to fit the available area in your mix. For best 
results, select an image with a corresponding aspect ratio. 
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5.4 MIX TEMPLATES 
 
After a video mix has been created, it can be saved as a template. 
 

3.1.1. CREATING A MIX TEMPLATE 
 

1. Ensure that your mix in the Video Mix Pane appears as desired. 
 

2. Under the Video Inputs column, assign a color to each input. Each input must have a unique 
color. 

 

 
 
 

3. Expand the Mix Templates section 
 

 
 

4. Under the Mix Templates section, click the + Template button.  
 

5. A new template representing the layout of your mix will appear in the Mix Templates section. Each 
color in the template represents a video input in the mix. The template contains the size, position and 
all other attributes of the video input as it appears in your video mix. 

 

 
 

Figure 49 – Creating a Mix Template 
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5.4.1 APPLYING A MIX TEMPLATE 

 
After a Mix Template has been created, you can apply the template to easily create other mixes. Follow 
the steps below to apply a Mix Template. 
 

1. Under the Video Inputs column, assign each input with the corresponding color of the Mix 
Template to be applied. 
 
 
 
 

2. Expand the Mix Templates section. 
 
3. Under the Mix Templates section, click on the Mix Template to be applied. 

 

 
 

Figure 50 – Applying Mix Template 

 
4. The mix in the Video Mix pane should represent the layout based on the colors you assigned to 

your Video Inputs. 
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6 PRESETS 

 
 

Figure 51 – Presets Column 

Presets allow you to switch between different mixes and camera positions for the same output during a 
recording. They can be made from any mix or output mix. 
 

 

1. Click on the +Preset button   
2. Enter a Name 
3. Enter a Description 

 
 

 

 

Drag and drop the desired Video and Audio 
Outputs or the Mix into the appropriate Preset. 

Figure 52 – Associating Audio and Video Mixes to Presets 
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7 RECORDING 
 

7.1 IN THE BUILDER INTERFACE 
 
 
Clicking on this button       saves the current configuration and brings you back to the Start Menu. 
 
 
 
To start a recording, choose the Touch Session and select “Current” (selects the last 
session configuration that was accessed) or a previously saved configuration. 
 
Please refer to the Touch Interface part of this guide. 
 
 

7.2 IN THE STUDIO INTERFACE 
 
To start a recording, click the Record button.  
 

 
 
During the recording, the Record button flashes in red. 
 

 
 

 
While the recording is in process, the presenter can deliver a presentation as he or she normally would. 
The presets can be selected during the recording to switch among the various audio and video mixes for 
the outputs. 
 
To stop a recording, click the Record button once more. 
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TOUCH INTERFACE 
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TOUCH INTERFACE 
 
The Touch Interface is a simplified interface that includes only the functionality a presenter or non-
technical operator requires to start and stop a recording or live broadcast and switch among presets 
created in the Builder / Studio Interface. 
 
The Touch Interface is designed for presenters and non-technical operators enabling users to easily 
create a recording and broadcast live without requiring configuration and management of audio and video 
presets. 
 

 

Note: Using the Touch Interface requires session configurations to have been previously made in 
the Builder / Studio interface. 

 
 
 

1. From Amalga’s Start screen, select the Touch Session button to launch the application.  
 

 
 
A list of available Session Configurations will appear as buttons. 

 
2. Select a Session Configuration. 

 

 
 

Figure 53 – Touch Session / Start Screen 
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Figure 54 – Touch Session Interface 

Clicking this button     brings you back to the Touch Session start screen where you can choose a 
Session Configuration. 
 

PRESETS 
 
Presets created in the Builder / Studio Interface will appear in the Touch Session Interface. 
Each preset contains the functionality defined in the Builder / Studio Interface when they were created. 
 
 

RECORDING IN TOUCH INTERFACE 
 
To start a recording, click the Record button.  
 

 
 
During the recording, the Record button flashes in red. 
 

 
 

 
While the recording is in process, the presenter can deliver a presentation as he or she normally would. 
The presets can be selected during the recording to switch among the various audio and video mixes for 
the outputs. 
 
To stop a recording, click the Record button once more.  
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LIVE BROADCAST 
 

1. Start a Studio Session. 
 

2. Open Session Properties by clicking this button.   
 

3. Select the Outputs tab. 
 

 
 

Figure 55 – Session Properties Window / Outputs Tab 

4. Click the Create… button. 
 

5. Select Live. 
 

6. Select the desired type of output for the live broadcast. 
 

   
 

Figure 56 – Output Wizard / Category 
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Figure 57 – Output Wizard / Type / Live 

7. Click on the Next> button. 
 
8. Complete the fields “name”, “profile”, and select the appropriate “Action” for the live broadcast 

that you choose. 
 

9. Click on the Options button. 
 
10. Complete the broadcast section appropriately and check the Enabled checkbox. 

 

  

Note: Media and / or Web servers must be configured in advance. 
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Figure 58 – Output Wizard / Type / Live / Smooth Streaming / Configuration Options 

 

  
 
 

Figure 59 – Output Wizard / Type / Live / RTMP / Configuration Options 
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Figure 60 – Output Wizard / Type / Live / HLS / Configuration Options 

11. If choosing an adaptive bit rate streaming output, enable the desired number of video streams 
by checking the appropriate checkboxes. The resolution, frame rate, and target bit rate of each 
video stream can be modified. 

 

 
 
 

 
Figure 61 – Output Wizard / Type / Live / Video Stream Options 
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Windows Media Silverlight H.264 for Flash iPhone 

Click on create, select Live, 
then select Windows Media 
Output  

Click on create, select Live, 
then select Silverlight 
Output 

Click on create, select Live, 
then select H.264 for Flash 
Output 

Click on create, select Live, 
then select iPhone Output 

 
a. Access the options 
 
b. Select your Broadcast 
option: Broadcast (Pull) 
and/or Broadcast (Push) 
 
c. If you choose the Push 
method: 
Enter the broadcast URL in 
the form: 
 
http://{IP address of the 
media server}:{WMS HTTP 
control protocol 
port}/{publishing point 
name} 
 
d. Validate your changes 
 
 

 
a. Access the options 
 
b. Select your Broadcast 
option: Broadcast (Pull) 
and/or Broadcast (Push)  
  
c. If you choose the Push 
method: 
Enter the broadcast URL in 
URL. 
 
http://{IP address of the 
media server}:{WMS HTTP 
control protocol 
port}/{publishing point 
name} 
 
d. Validate your changes 
 

 
a. Access the options and 
enable broadcast. 
  
b. Streaming video port by 
default is 1100 and audio 
port number is 1102. You 
must use another port 
number if you do multiple 
streams. 
  
c. Protocol is using RTP 
(Real-Time Transport 
Protocol) over UDP (User 
Datagram Protocol). 
  
d. Configure a unicast or 
multicast stream: 
 
i. For unicast, type the 
address of the server to 
stream to in the Destination 
address. 
 
ii. For multicast, contact 
your Network Administrator 
and set up the Destination 
address and the SAP 
announcement parameters. 
  
e. You also have the option 
to use the SDP (Session 
Description Protocol) file. In 
the SDP box, enter the 
URL or destination where 
the SDP file will be 
available. 
 
f. Validate your changes 
 

 
a. Access the options and 
enable broadcast. 
 
b. Streaming video port by 
default is 1100 and audio 
port number is 1102. You 
must use another port 
number if you do multiple 
streams. 
 
c. Protocol is using RTP 
(Real-Time Transport 
Protocol) over UDP (User 
Datagram Protocol). 
 
d. Configure a unicast or 
multicast stream: 
 
i. For unicast, type the 
address of the server to 
stream to in the Destination 
address. 
 
ii. For multicast, contact 
your Network Administrator 
and set up the Destination 
address and the SAP 
announcement parameters. 
 
e. You also have the option 
to use the SDP (Session 
Description Protocol) file. In 
the SDP box, enter the 
URL or destination where 
the SDP file will be 
available. 
 
f. Validate your changes 
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RTMP Smooth Streaming HLS 

Click on create, select Live, 
then select H.264 for Flash 
Output 

Click on create, select Live, 
then select Smooth 
Streaming Output 

Click on create, select Live, 
then select HLS Output 

 
a. Access the options and 
enable broadcast (RTMP). 
 
b. Enter the broadcast URL 
in URL. 
 
c. Rename the stream for this 
instance of the RTMP 
broadcast. 
 
d. Enter the credentials in the 
Username and Password 
fields. 
 
e. Validate your changes  
 
 
 

 
a. Access the options and 
enable broadcast. 
 
b. Enter the broadcast URL 
in URL. 
 
http://{IP address of the 
media server}:{IIS media 
services port}/{publishing 
point name}.isml 
 
c. Enter the credentials in the 
Username and Password 
fields. 
 
d. Enable the desired number 
of video streams to be used. 
 
e. Modify the resolution and 
bit rate of each video stream 
if desired. 
 
f. Validate your changes 
 
g. If secondary broadcast is 
enabled, repeat steps a. – e. 
 
 

 
a. Access the options and 
enable broadcast. 
 
b. Enter the broadcast URL 
in URL. 
 
http://example-
i.akamaihd.net/ 
{stream_id}/ {event_name} 
 
c. Enter the credentials in the 
Username and Password 
fields. 
 
d. Enable the desired number 
of video streams to be used. 
 
e. Modify the resolution and 
bit rate of each video stream 
if desired. 
 
f. Specify the duration in 
which the manifests will be 
available in the Window field 
 
g. Validate your changes 
 
h. If secondary broadcast is 
enabled, repeat steps a. – f. 
 
*Please note that the 
broadcast URL is valid only 
for Akamai’s network. 
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DISPLAY/PROJECTOR OUTPUT 
 

1. Start a Studio Session 
 

2. Open Session Properties by clicking this button.   
 

3. Select the Outputs tab. 
 

 
 
 

Figure 62 – Studio Session / Session Properties / Outputs Tab 

4. Click on the Create… button. 
 

5. Select A/V Equipment. 
 

6. Select Display/Projector. 
 

 
 
 

Figure 63 – Output Wizard / Category 
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Figure 64 – Output Wizard / Category / A/V Equipment 

 

7. Click on the Next> button. 
 
8. Complete the fields “name”, “profile”, and select the appropriate “Action.” 

 
9. Click on the Options button. 

 
10. You can select which Screen you want the output to be displayed on. You can also modify the 

screen resolution, frame rate, and enable/disable video animations. 
 

 
 

                          
Figure 65 – Output Wizard / Category / A/V Equipment 

11. Click on the OK button. 
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UNLIMITED ACTIVE OUTPUTS 
 
Allows you to record more than one output at a time. 
 

SCHEDULER 
 
The Scheduler allows you to schedule recordings in advance. Scheduled recordings can be configured 
to repeat daily or weekly. This is useful for recording regularly scheduled events such as classroom 
lectures. 
 

 
 

Figure 66 – Example of Scheduled Recordings for One Classroom  

To create a new scheduled recording, follow the steps below. 
 

 
 

Figure 67 – Scheduler Task Editor 

From the Scheduler dialog, click the Create… button to launch the Scheduler Task Editor. 
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In the Scheduler Task Editor, enter a Name for the scheduled recording. 
 
Select the appropriate Session File for the scheduled recording. 
 
Specify the Start Date/Time for when the recording is to start. A calendar will appear when you click on 
the white arrow next to the Date field for easy date selection. 
 
Specify the Duration for which the recording should last in hh:mm:ss format. 
 
Check the Repeat checkbox if the recording is to occur regularly. 
If Repeat is checked, specify which Days of the week the recording should occur. 
 
For repeating recordings, specify the Expire Date for the recording. The Expire Date is the date after 
which the recording will no longer occur and will be removed from the Scheduler. 
 
Enter the Password for the Windows user account that is scheduling the recording. The Windows user 
name appears in the User box above the Password field. 
 

 

Important Notes on Working with the Scheduler 

 
Only a user with Administrative privileges can access Amalga’s scheduling features. 
 
Scheduling a recording requires a password. If a user account is created under which scheduled 

recordings will run, a password is required for that user. 
 
Scheduled tasks will only run on the Windows account that created the scheduled recoding. If recordings were 
scheduled under the Administrator account, you must be logged into the Administrator account for those recordings 
to run.  
 
When scheduling a recording, ensure that the recording does not overlap a previously scheduled recording. 
Please note that the scheduler does not work on a profile (Administrator/User) without a password. 
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EVENTS 
 

 
 

Figure 68 – Events Column 

Events can enhance a presentation with the ability to add meaningful data to the presentation during a 
recording. A user/presenter can create a chapter at any point in a presentation, insert captions which will 
appear in the close captioning area of the Silverlight player, or insert search terms allowing the viewers to 
search on a keyword. 
 
A user/presenter can also add post-production Events to signify to the video editor, including specific 
notes for the editor as well as segments of the video to be removed via Mark In/Out feature. 
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The Events feature is available under the Events tab in the Studio Interface. 
 
 

 

 
To create an event: 
 
In the Cue pane, click on an Event button 
(Chapter, Caption, Search, URL, Mark In, Mark 
Out, Note, Custom). 
 
Enter the appropriate text in the field provided. 
 

Specify a time for the event or click the   
button to set the current time of the recording. 

 

 

Click on the  button to apply it to the timeline. 
The Event should now appear in the Monitor 
pane. 

To remove an event, click on the  button in 
the Monitor pane and it will appear back in the 
Cue pane. 

Click the  button to cancel the Event 
completely. 

 

Figure 69 - Adding Events 
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The following list describes each of the Events that can be added during a recording. 
 

 CHAPTERS 

Chapters can be added to specify areas in a recording a presenter may wish to identify as a key segment 
in a discussion. By adding a title, a chapter is created with the title the user/presenter has specified. 
 
Note: Amalga will also create chapters automatically based on text captured from images captured. 
 
Usage example: A presenter may discuss a single image (or presentation slide) at length. The 
user/presenter could create Chapter events at different times during the discussion of that slide so that 
viewers can navigate to specific points during that slide. 
 

 CAPTION 

A Caption can be added to a recording by sending a Captions event. These captions appear in the 
closed captioning area typically occupied with closed captioning text that appear when the CC button in 
the Winnov Silverlight players is pushed. 
 
Usage example: A user/presenter can take advantage of this feature by adding captioning notes to 
display to the audience. This could be useful to display text to highlight key concepts or to display a 
mathematical formula. 
 

 SEARCH 

Search terms can be added to a recording to make any segment of a presentation searchable.  
 
Usage example: A presenter with a speech-only discussion (slides not used) will not have automatic 
chapter creation or searchable text. The user/presenter may wish to insert searchable keywords 
pertaining to various segments of the discussion so the viewer can search for that portion of the 
presentation. 
 

 URL 

A URL event can be sent during the recording if a presenter wishes to add a URL as a resource during a 
presentation. 
 
Usage example: A presenter may have a web resource available that is not available in a presentation 
slide. To make this URL available to the viewer, the user/presenter can send a URL event to provide a 
link of the online resource to the viewer. 
 
Note: To use the URL event requires a custom script to be written to launch a browser window. 
 

 MARK IN / MARK OUT 

The Mark In and Mark Out events are used for post-production of a recording. Sending these events 
during a recording will mark the timeline with “In” and “Out” and is viewable in Microsoft’s Expression 
Encoder. If the presentation requires editing, an editor can view the timeline for these “In” and “Out” 
marks and remove portions of the video accordingly. 
 
Usage example: A user/presenter can start a recording as the audience is being seated and may only 
want to keep the speaking portions of the recording. The user/presenter can Mark In at the moment the 
actual presentation is started and Mark Out during intermission or at the end of the presentation. The 
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user/presenter can Mark In and Out as many times as needed to produce a single video without 
intermissions or other irrelevant events. 
 

 NOTE 

The Note event is used to provide notes for a video editor for post-production of a recording if any is 
required. The note will appear within Microsoft Expression Encoder’s Script Commands pane. 
 
Usage example: The user/presenter can send a Note event during a recording to flag a segment of the 
video to a post-production editor. This note can specify details about a part of a recording that the 
presenter would like an editor to review and edit in Expression Encoder 4. 
 

 CUSTOM 

The Custom event is used to add a custom script into the timeline, which can be used to launch an 
event. 
 
Usage example: With a Custom script event embedded into the video timeline, a script can be written to 
“listen” for custom scripts to run a command at strategic times to launch a survey window, for example. 
 
 
  



WINNOV CBOX SOFTWARE USER GUIDE  69 

 

 

 
 

 

 

 

 

 

 

 

 

OPTIONAL FEATURES 
 
 

  



WINNOV CBOX SOFTWARE USER GUIDE  70 

 

 

LIST OF OPTIONAL FEATURES 
 
The following features are optional. They may be disabled or not supported on your Cbox. 
A feature may be disabled because this is a lower cost Cbox. However, it is possible to enable a feature 
upon approval of your account manager at Winnov. 
A newer feature may not be supported because this is an older Cbox platform. However, it is possible to 
upgrade your hardware within the conditions of your Cbox support plan. 
 

Additional 
Input Channels 

High Definition Inputs 

- Some appliances have two HD inputs (RGB/DVI/HDMI/Component and HD/3G-SDI) 
enabled by default. With the Additional Input Channels, you can enable up to two more 

HD inputs. 
Audio Inputs 

- Some appliances have two audio inputs (Analog, SDI embedded audio channels, HDMI 
embedded audio channels) enabled by default. With the Additional Input Channels, 

you can enable up to two more audio (analog and embedded audio) inputs. 
 

Additional 
Session 
Outputs 

Allows you to use more than one output (for recording, live broadcast streams, or 
audience/projector). 
 

- Some appliances have one active session output enabled by default. With the Additional 
Session Outputs, you can enable up to two more session outputs. 
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1 ACTIONS PACKAGE 

1.1. WHAT IS THE ACTIONS PACKAGE? 
 
The Actions Package contains a set of scripts, which are run when you start and/or stop a recording. 
 
An Action is typically selected to determine which player will be created for specific output types. When 
creating an output in Amalga, you can specify an Action under the Actions drop-down menu if any Action 
is available for that output. 

1.1. INCLUDED ACTIONS IN THE PACKAGE 
 

Action Description 

HTML_Classic 
HTML player with embedded Windows Media Player and image 
stream 

HTML_Classic_Live Live Windows Media streaming player with image stream 

HTML5  HTML5 player for Silverlight H.264 output with fallback to Silverlight 

Silverlight 

 

Silverlight_Duo player: dual video player displaying two video inputs 

H.264 version of the Silverlight_Duo player 

Live streaming version of the Silverlight_Duo player 

Smooth streaming version of the Silverlight_Duo player 

Live smooth streaming version of the Silverlight_Duo player 

Silverlight_Multiview: multi-video player with moveable video windows 
for user-controlled viewing 

H.264 version of the Silverlight_Multiview player 

Live streaming version of the Silverlight_Multiview player 

Smooth streaming version of the Silverlight_Multiview player 

Live smooth streaming version of the Silverlight_Multiview player 

Silverlight Video + Images player: player displaying one input as video 
and a second input as images 

H.264 version of the Silverlight_Video+Images player 

Live streaming version of the Silverlight_Video+Images player 

Smooth streaming version of the Silverlight_Video+Images player 

Live smooth streaming version of the Silverlight_Video+Images player 

Hinted_Stream Hinting option for H.264 outputs 

 
 

 

Note: All sample HTML5 and Silverlight players display chapters and thumbnails as captured 

by Amalga. They are indexed and searchable. 
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1.2. INSTALLATION INSTRUCTIONS 
 

To install the Actions Package: 
 

1. After downloading the package, make sure to: 
- Right-click on the zip file 
- Go to Properties and click "Unblock" (File coming from another computer might be blocked to 

help protect your computer.) 
 

2. Unzip and copy the contents of this archive. 
 

3. Paste the contents into the system's Actions folder found in the path below: 
 

- Windows 2003: C:\Documents and Settings\All Users\ApplicationData\Amalga\Actions 
- Windows 2008 and 7: C:\ProgramData\Amalga\Actions 

 
Create the appropriate directories if they do not exist. 
 

4. The Actions are now ready to use and will appear under the Action dropdown menu if the Action 
is associated with the selected output. 

 

Below is an example of the HTML5 + Silverlight 

action associated with the Silverlight H.264 

output: 

Below is an example of the Silverlight action 

associated with the Silverlight H.264 output: 
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2 CUSTOMIZING THE SILVERLIGHT PLAYER 
 

The Silverlight player can be customized and branded. A custom logo can be added and changes to the 

color scheme can be applied to the player’s background, foreground, header, and control bar. 

2.1. BRANDING THE PLAYER 
To brand the player with a custom logo: 

 

1. Go to the Actions folder and then navigate to “Silverlight/Player”. 

 

2. In the player folder, delete the existing “branding.png” image, then add the desired image to be 

used for branding and rename it to “branding.png.” 

 

3. The custom logo will now appear in the upper left-hand corner of the Silverlight player. 
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2.2. MODIFYING THE COLOR SCHEME AND ICONS  

 
Player.xaml contains a Silverlight resource dictionary. Named values are used to customize the look of 

the Silverlight player(s). Basic color changes and modifications to icons can be applied. Color changes 

are done using the named brushes.  

 

Note: The layout cannot be modified.  

 

For information on Silverlight brushes, please visit: 

http://msdn.microsoft.com/en-us/library/system.windows.media.brush(v=vs.95).aspx 

 

The various named brushes are described below. 

PlayerBackgroundBrush The background for the whole player 

PlayerForegroundBrush The foreground for the whole player (influences text) 

PlayerBrandingBackgroundBrush 
The background for the branding area. Typically you would set this 
such that it would be appropriate for your branding image. 

PlayerControlsBackgroundBrush 
The background for the controls area. Note that the default value is a 
LinearGradientBrush. This could just as easily be a SolidColorBrush. 

PlayerControlsForegroundBrush The foreground for the controls area (influences text) 

PlayersIconsBrush Used only within this dictionary. Used to quickly change all the icons. 

 

Controls.xaml contains a Silverlight resource dictionary. This is essentially a partial Silverlight "theme". 

The resource dictionary contains only control templates for controls which are used in the player(s). It is 

possible to swap in a complete theme (containing control templates for most basic controls and toolkit 

controls).  

Note: For most basic color changes, Player.xaml should be the first point for modification.    

To make modifications to the color scheme and icons: 

 

1. Go to the Actions folder and then navigate to “Silverlight/Player”. 

 

2. Change the file name extension of player.xap to player.zip. When asked if you want to change 

the file name extension, answer Yes.  

 

3. Open player.zip.  

 

4. Copy Player.xaml and then press the back button. 

 

5. Paste Player.xaml in the “Silverlight/Player” directory 

  

6. Use a text editor (such as Notepad) to edit Player.xaml 

 

http://msdn.microsoft.com/en-us/library/system.windows.media.brush(v=vs.95).aspx
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7. Modify the desired fields by entering in hexadecimal values or basic color names (e.g., black, 

white, blue). 

 

8. Save the changes. 

 

9. Change the file name extension of player.zip back to player.xap. When asked if you want to 

change the file name extension, answer Yes.  

 

10. The Silverlight player will now apply and display the changes made to the color scheme and 

icons.  

 

Below is an example of a branded player with various modifications applied to it. 
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3 HTML5 PLAYER BROWSER AND OPERATING SYSTEM 

COMPATIBILITY 
 

3.1 HTML5 DESKTOP PLAYER COMPATIBILITY 
 

The following tables indicate the various desktop operating system versions and web browser versions 

which are compatible with the Winnov HTML5 rich media desktop player. 

 

Desktop 

Operating 

System 

Windows XP Windows 7 Windows 8 Windows 8.1 

Web Browser 

Version 

Firefox 22.0 IE 10.0 Firefox 22.0 IE 11.0 

Firefox 23.0 IE 11.0 Release 

Preview 
Firefox 23.0 Firefox 22.0 

Firefox 24.0 Firefox 22.0 Firefox 24.0 Firefox 23.0 

Firefox 25.0 

beta 
Firefox 23.0 Firefox 25.0 

beta 
Firefox 24.0 

Safari 5.1 Firefox 24.0 Safari 5.1 Firefox 25.0 

beta 

Chrome 25.0 Firefox 25.0 beta Chrome 25.0 Safari 5.1 

Chrome 26.0 Safari 5.1 Chrome 26.0 Chrome 25.0 

Chrome 27.0 Chrome 25.0 Chrome 27.0 Chrome 26.0 

Chrome 28.0 Chrome 26.0 Chrome 28.0 Chrome 27.0 

Chrome 29.0 Chrome 27.0 Chrome 29.0 Chrome 28.0 

Chrome 30.0 Chrome 28.0 - Chrome 29.0 

Chrome 31.0 Chrome 29.0 - - 
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Desktop Operating 

System 

OSX Snow Leopard 

 

OSX Lion 

 

OSX Mountain Lion 

 

Web Browser 

Version 

Firefox 22.0 Firefox 22.0 Firefox 22.0 

Firefox 23.0 Firefox 23.0 Firefox 23.0 

Firefox 24.0 Firefox 24.0 Firefox 24.0 

Firefox 25.0 beta Firefox 25.0 beta Firefox 25.0 beta 

Safari 5.1 Safari 5.1 Safari 5.1 

Chrome 25.0 Safari 6.0 Safari 6.0 

Chrome 26.0 Chrome 25.0 Chrome 25.0 

Chrome 27.0 Chrome 26.0 Chrome 26.0 

Chrome 28.0 Chrome 27.0 Chrome 27.0 

Chrome 29.0 Chrome 28.0 Chrome 28.0 

Chrome 30.0 Chrome 29.0 Chrome 29.0 

Chrome 31.0 Chrome 30.0 Chrome 30.0 

- Chrome 31.0 Chrome 31.0 
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3.2 HTML5 MOBILE AND TABLET PLAYER COMPATIBILITY 
 

The following tables indicate the various mobile and tablet device types and operating system and 

browser versions which are compatible with the Winnov HTML5 rich media mobile player. 

Mobile & 

Tablet Device 

Type 
Apple Android Windows Blackberry 

Operating 

System & 

Browser 

Version 

iOS Safari 3.2 Android 2.1 
IE Mobile 10 

 

Blackberry 7 

iOS Safari 4.0 Android 2.2 - Blackberry 10 

iOS Safari 4.1 Android 2.3 - - 

iOS Safari 4.2 Android 3.0 - - 

iOS Safari 4.3 Android 4.0 - - 

iOS Safari 5.0 Android 4.1 - - 

iOS Safari 5.1 Android 4.2 - - 

iOS Safari 6.0 Android 4.3 - - 

iOS Safari 6.1 - - - 

iOS Safari 7.0 - - - 
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3.3 HTML5 PLAYER FALLBACK AND FALL FORWARD 
 

During video playback, the HTML5 desktop player will automatically fall back to the Silverlight player if 

HTML5 video is not supported by the web browser.  

 

When playing back HTML5 video on a desktop, tablet or mobile phone, the device is automatically 

detected and the HTML5 player will apply the layout associated for that device. 
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4 CUSTOMIZING THE HTML5 PLAYER 
 

The HTML5 player can be customized and branded. A custom logo can be added and changes to the 

color scheme can be applied to the player’s: 

- Background  

- Fonts 

- Buttons 

- Icons 

- Controls  

The HTML5 player’s main file is index.html. It contains and uses references to jquery, jqueryUI, 

jquery.dialogextend, and the raphael svg library. 

The HTML5 player is branded through the “config.js” file located in the js folder. 

For the HTML5 player, it is possible to create your own branding.css file in order to brand the player.  Just 

name the file “branding_mybrandingname.css.”  A branding file may be called by adding 

“?branding=mybrandingname” after the index.html in the location bar of your browser.  This allows for one 

player to be branded multiple ways. If branding isn't passed to the player, it defaults to Winnov branding. 

You can also pass the weburl and mediaurl to the player by passing them through the http query strings.  

These urls must be properly encoded. 

 

4.1 PLAYER FOLDER CONTENTS 
The various folders and the contents of each are described below: 

Source folder contents Description 

branding.png Branding for the Silverlight player 

index.html Main file for the HTML5 player 

index_phone.html File used for mobile phones 

index_tablet.html File used for tablets 

player.htm Silverlight player 

WinnovLogo_white.svg Scalable branding file for the default Winnov branding 

 

Note: With the branding scheme, the branding image information is entered into the 
branding_mybranding.css file. Your branding file can be named whatever you like and can be 
any file format supported by web browsers (jpg, png, gif, svg). 
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CSS folder contents Description 

ui-lightness folder This folder is for the jquery-ui package 

branding.css Default Winnov branding  

layout.css Layout file for desktop player 

layout_phone.css Layout file for mobile phone player 

layout_tablet.css Layout file for tablet player 

 

 

Icons folder contents Description 

icon-chapters.svg 

All the svg icons for the mobile page icons. These 
files will likely go away in favor of dynamically 
generated raphael based svg files for easier color 
branding of icons. 

icon-chapters-highlighted.svg 

icon-close.svg 

icon-links.svg 

icon-links-highlighted.svg 

icon-search.svg 

icon-search-highlighted.svg 

icon-thumbnails.svg 

icon-thumbnails-highlighted.svg 

 

 

JS folder contents Description 

config.js 
user editable configuration file for the players (currently desktop 
only) 

iscroll.js MIT licensed file to enable touch scrolling on mobile devices 

jquery.dialogextend.min.js MIT licensed extension for jquery 

jquery.-1.9.1.js and jquery-
min.js 

MIT licensed jquery library. These will be consolidated to just 
jquery-min.js 

jquery-ui-***.js MIT licensed jquery library 

pagefunctions_***.js Winnov pagefunctions. These will be consolidated. 

raphael.min.js 
MIT licensed raphael graphics library. This will eventually be 
moved to the much smaller minified version. 
 

Silverlight.js 
Microsoft provided library for embedding Silverlight via 
javascript. 
 

jquery.fullscreen-0.3.5.min.js fullscreen plugin for jquery 
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4.2 BRANDING THE HTML5 PLAYER 
 

 

To brand the HTML5 player: 

 

1. Navigate to the css folder. 

 

2. Make a copy of “branding.css” and rename it to “branding_mybranding.css.” 

 

3. Modify branding_mybranding.css to suit your needs and to point to your logos. 

To load your branding file: 

1. Call the page using “http://mypage.com/index.html?branding=mybranding” 
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5 ABOUT THE OCR 
 
OCR (Optical Character Recognition) can be enabled in the options of specific output types such as 
Silverlight. 
 
It allows you to translate scanned images of handwritten, typewritten or printed text into machine-encoded 
text. 
 
OCR systems require calibration to read a text. 
 

 
 
 
OCR is most effective using large, black text on a white background. It is recommended to test with the 
medium intended to be captured (i.e. PowerPoint, document camera) and adjust the OCR settings 
accordingly. 
 
E.g., for a PowerPoint presentation we advise: 
Background color: light (white, light grey) 
Text color: Black 
Text font size: 32 
Title font size: 44-46 
Amalga OCR sensitivity: 0.2 
 
 

 

 Note: OCR sensitivity will largely depend on the amount of change that occurs between slides. 
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6 ADVANCED OUTPUT OPTIONS 

6.1. ADVANCED VIDEO STREAM OPTIONS 
 

Advanced Video Stream options for H.264 are described below. 

Video Format Resolution and frame rate 

Target Bit Rate Target compression bit rate in Kbps 

Profile Use the highest profile supported by all target platforms and devices. 

Level Device conformance level 

Performance 
Lower values produce much lower quality and higher values may result in much 
longer encoding time with only small improvements in quality. For live encoding, use 
the highest value that does not drop frames. 

Rate Control Mode 
VBR is useful for storing content for later processing, but has no rate control, so file 
size will be difficult to predict. 

Maximum Bit Rate Maximum bit rate in Kbps. Only valid for VBR. 

I-Quantization 
Lower values will provide better visual quality, but will use more bits per frames. 
Generally, values below 25 yield good results and values above 25 may show 
distracting artifacts. The range is 1 to 31. Only valid for CQP. 

P-Quantization 
Lower values will provide better visual quality, but will use more bits per frames. 
Generally, values below 25 yield good results and values above 25 may show 
distracting artifacts. The range is 1 to 31. Only valid for CQP. 

B-Quantization 
Lower values will provide better visual quality, but will use more bits per frames. 
Generally, values below 25 yield good results and values above 25 may show 
distracting artifacts. The range is 1 to 31. Only valid for CQP. 

Scene Change Detection Specifying true enables pre-processing modules to auto-detect scene changes. 

B-Frame Count Specifies the maximum consecutive B-frame count. The range is 0 to 3. 

Max Key Frame Distance 
Maximum distance between key frames. Must be greater than or equal to 1 + B-frame 
count. 

Entropy Coding Mode 
Use CAVLC for slower playback devices. CABAC is only supported in Main profile 
and higher. 
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Advanced Video Stream options for Windows Media are described below. 

Video Format Resolution and frame rate 

Target Bit Rate Target compression bit rate in Kbps 

Profile 
Use the highest profile supported by all target platforms and devices. 
Main profile is a good choice for Windows Media. Use simple profile only 
for very low-power devices. 

Quality 
Lower values will provide better quality, but will use more bits per frame. 
Generally, values below 8 yield good results and values above 8 may 
show distracting artifacts. The range is 1 to 31. 

Rate Control Mode 
VBR is useful for storing content for later processing, but has no rate 
control, so file size will be difficult to predict. 

B-Frame Count Maximum number of consecutive B-frames. The range is 0 to 7. 

Max Key Frame Distance 
Maximum distance between key frames. Must be greater than or equal 
to 1 + B-frame count. 

Look Ahead 

Specifying true enables pre-processing modules such as flash detection, 
which enables the encoder to intelligently place B-frames and I-frames 
to optimize compression. This optimization offers some of the B-frame 
quality improvements that would otherwise require 2-pass encoding. 
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6.2. ADVANCED AUDIO STREAM OPTIONS 
 

Advanced Audio Stream options for H.264 are described below. 

Bit Rate Target compression bit rate in Kbps 

Rate Control Mode Variable or constant bit rate control  

VBR Quality Quality of the VBR compression 

 

 

 

Advanced Audio Stream options for Windows Media are described below. 

Bit Rate Target compression bit rate in Kbps 

Language Language string compliant with RFC 1766  
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6.3. ADVANCED ARCHIVE OPTIONS 
 

Advanced Archive options for H.264 are described below. 

File Name Name of the target file 

Output Format Output file format 

Compatibility 
Generates an MP4 file meeting specific compatibility requirements for 
certain devices or standards 

Output Folder Location of target file 

 

 

 

Advanced Archive options for Windows Media are described below. 

File Name Name of the target file 

Auto Index Auto-indexing creates a time-based index for the file. 

Maximum Packet Size 
Maximum packet size, in bytes. Set this to zero if the writer is to 
generate packets of various sizes. Otherwise, it must be a value 
between 100 bytes and 64 kilobytes. 

Output Folder Location of target file 
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